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ةمدقملا

ةيفيكو ،ISE تاداهش راودأو عاونأو ،Cisco ISE يف TLS/SSL تاداهش دنتسملا اذه فصي
.ةلوادتملا ةلئسألا ىلع تاباجإلاو ،اهحالصإو ءاطخألا فاشكتساو ةعئاشلا ماهملا ذيفنت

ةيساسألا تابلطتملا

تابلطتملا

:ةيلاتلا عيضاوملاب ةفرعم كيدل نوكت نأب Cisco يصوت

.Cisco (ISE)1 نم ةيوهلا تامدخ كرحم
.AAA.2 و ISE رشن تايلمع نم ةفلتخم عاونأ فصول ةمدختسملا تاحلطصملا
.AAA3 تايساسأو RADIUS لوكوتورب
.x5094 و SSL/TLS تاداهش



.5(PKI) ماعلا حاتفملل ةيساسألا ةينبلا تايساسأ

ةمدختسملا تانوكملا

نم 2.7 - 2.4 تارادصإلاو ،Cisco ISE تارادصإ ىلإ دنتسملا اذه يف ةدراولا تامولعملا دنتست
نوكي نأ بجي ،كلذ عمو ،2.7 ىلإ 2.4 رادصإلا نم ISE يطغي وهو .ةيداملا تانوكملاو جماربلا
.كلذ فالخ ىلع صني مل ام ISE 2.x نم ىرخألا جماربلا تارادصإل اقباطم وأ الثامم

.ةصاخ ةيلمعم ةئيب يف ةدوجوملا ةزهجألا نم دنتسملا اذه يف ةدراولا تامولعملا ءاشنإ مت
تناك اذإ .(يضارتفا) حوسمم نيوكتب دنتسملا اذه يف ةمدختسُملا ةزهجألا عيمج تأدب
.رمأ يأل لمتحملا ريثأتلل كمهف نم دكأتف ،ليغشتلا ديق كتكبش

مداخلا تاداهش

اهتلاصأ ىلع لوصحلل ءالمعلل مداخلا ةيوه ميدقتل مداخلا تاداهش مداوخلا مدختست
ةداهشلا مداخلا ردصي ثيح) ايتاذ ةعقوم هذه نوكت نأ نكمي .لاصتالل ةنمآ ةانق ريفوتلو
.(فورعم دروم نم وأ ةسسؤملل يلخاد امإ) قدصم عجرم نم ةرداص وأ (هسفنل

لهؤملا لاجملا مسا) FQDN وأ فيضملا ءامسأ ىلإ يجذومن لكشب مداخلا تاداهش رادصإ متي
وأ (فيضملا) فيضملا .(domain.com.*) لدب فرح ةداهش اضيأ نوكت نأ نكمي وأ ،مداخلل (لماكلاب
(مسالا) مسالا) يلقح يف صاخ لكشب روكذم هيلإ هرادصإ متي يذلا يعرفلا لاجملا وأ لاجملا
.(SAN) ليدبلا عوضوملا مسا وأ (CN) عئاشلا

مسا نم الدب ةيمجن ةمالع) لدب فرح نيودت مدختست SSL تاداهش يه لدبلا فرحأ تاداهش
.ةسسؤم يف نيددعتم نيفيضم ربع ةداهشلا سفن ةكراشمب حمست يلاتلابو (فيضملا
عوضوملا مسا لدبلا فرحأ تاداهشل SAN وأ CN ةميق ودبت نأ نكمي ،لاثملا ليبس ىلع
 ،server1.com  لثم لاجملا اذهل نيفيضم يأ نيمأتل همادختسإ نكميو company.com.*  ل لثامم
server2.com، اذكهو.

.لثامتملا ريغ ريفشتلا وأ ماعلا حاتفملا ريفشت ةداع تاداهشلا مدختست

هتكراشم متيو ،لوقحلا دحأ يف ةداهشلا يف ادوجوم ماعلا حاتفملا نوكي :ماعلا حاتفملا
.هب لاصتالا ام زاهج لواحي امدنع ماظن ةطساوب ماع لكشب

●

نكمي .ماعلا حاتفملاب نرتقيو يئاهنلا ماظنلاب صاخ صاخلا حاتفملا :صاخلا حاتفملا
صاخلا حاتفملا ةطساوب طقف ماع حاتفم ةطساوب ةرفشملا تانايبلا ريفشت كف
.سكعلاب سكعلاو ددحملا جودزملا

●

ISE تاداهش

طاقن عم نمآ لاصتا ريفوتل (PKI) ماعلا حاتفملل ةيساسألا ةينبلا ىلع Cisco ISE دمتعي
ددعتم رشن يف Cisco ISE دقع نيب كلذكو ،كلذ ىلإ امو نييرادإلاو نيمدختسملاو ةياهنلا
ريفشتل ةماعلا حيتافملا لقنل X.509 ل ةيمقرلا تاداهشلا ىلع PKI دمتعت .تايسنجلا
نيمدختسملا نم ةمدقملا ىرخألا تاداهشلا ةلاصأ نم ققحتللو ،اهريفشت كفو لئاسرلا
:ةداع ةمدختسملا تاداهشلا نم نيتئف ىلع Cisco ISE يوتحي .ةزهجألاو



Cisco ةدقع لكل نوكي .ءالمعلل Cisco ISE ةدقع فرعت مداخ تاداهش هذه :ماظنلا تاداهش
ISE صاخلا حاتفملا عم ةدقعلا ىلع اهنم لك نيزخت متيو ،ةصاخلا ةيلحملا اهصيخرت
.ينعملا

●

ققحتلل مدختست (CA) قيدصت عجرم تاداهش يه :تاداهشلا اهب قوثوملا تاداهشلا نزخت
يف ةدوجوملا تاداهشلا هذه ةرادإ متتو .ةفلتخم ضارغأل ISE ىلإ ةمدقملا تاداهشلا نم
عيمج ىلإ الثامتم اخسن اهخسن متيو "ةيساسألا ةرادإلا" ةدقع ىلع "تاداهشلا نزخم"
متي تاداهش ىلع اضيأ تاداهشلا نزخم يوتحي .عزوملا Cisco ISE رشن يف ىرخألا دقعلا
.BYOD ل ةصصخملا ISE ةيلخادلا صيخرتلا ةئيه ةطساوب ISE دقعل اهؤاشنإ

●

ماظنلا تاداهش

هحرش يرجيو افلتخم ادصق مدخي رود لكو .رثكأ وأ دحاو رودل ماظنلا تاداهش مادختسإ نكمي
:انه

Admin: 443 ربع تالاصتالا عيمج نيمأتل رمألا اذه مادختسإ متي (Admin GUI)، ةفاضإلاب
.انه جردم ريغ مادختسإ/ذفنم يألو ،لثامتملا خسنلا ىلإ

●

ةقداصم ةباوب لثم لخادملا ربع HTTP لاصتا نيمأتل رايخلا اذه مادختسإ متي :ةباوبلا
ءالمعلا دادمإ تاباوبو ،ليمعلا دادمإو ،BYOD و ،فيضلاو ،(CWA) ةيزكرملا بيولا
وه يضارتفالا) لخدم ةعومجم ةمالع ىلع لخدم لك نييعت بجي .كلذ ىلإ امو ،نييلصألا
متيس يتلا ةددحملا ةداهشلا ىلع لخدملا دشرت يتلاو (ةيضارتفا لخدم ةعومجم ةمالع
ريرحت تارايخ يف لخدملا ةعومجم مسا مسال ةلدسنملا ةمئاقلا كل حيتت .اهمادختسإ
.ةدوجوم زييمت ةمالع رايتخإ وأ ةديدج زييمت ةمالع ءاشنإ ةداهشلا

●

EAP: 802.1 ةقداصمل ءالمعلا ىلإ ةمدقملا ةداهشلا ددحي رود اذهx. عم تاداهشلا مدختست
مادختساب .اذكهو EAP-FAST و PEAP و EAP-TLS لثم ابيرقت نكمم EAP بولسأ لك
نيمأتل (TLS) لقنلا ةقبط نامأ مدختسي ،FAST و PEAP لثم يقفنلا EAP بيلاسأ
اذه ءاشنإ دعب الإ مداخلا ىلإ ليمعلا دامتعا تانايب لاسرإ متي ال .دامتعالا تانايب لدابت
.نمآ لدابت قيقحت نامضل قفنلا

●

RADIUS DTLS: لاصتال مدختست يتلا ةداهشلا رودلا اذه ددحي DTLS (لاصتا TLS ربع
UDP) رورم ةكرح ريفشتل RADIUS ةكبشلا ىلإ لوصولا زاهج نيب (NAD) و ISE. نأ بجيو
.ةزيملا هذه لمع ىلع ارداق DTLS ريفشت نوكي

●

SAML: ةيوه رفومب لاصتالا نيمأتل مداخلا ةداهش مدختست SAML (IdP). نكمي ال
امو EAP ةقداصمو Admin لثم ىرخأ ةمدخ يأل SAML مادختسال ةصصخم ةداهش مادختسإ
.كلذ ىلإ

●

syslog لوكوتورب نم الدب ISE ةلسارم ةمدخ ISE مدختسي ،2.6 ماع ذنم :ISE ةلسارم ةمدخ
.لاصتالا اذه ريفشتل اذه مدختسي .تانايبلا ليجستل ميدقلا

●

PxGrid: تامدخل ةداهشلا هذه مدختست PxGrid ىلع ISE.●

،EAP ةقداصمل نيعم اذه .Default Self-Signed Server Certificate  ءاشنإب موقي هنإف ،ISE تيبثت دنع
قدصم عجرم ىلإ راودألا هذه لقنب ىصوي .ايضارتفا RADIUS DTLS و ،لخدملاو ،لوؤسملاو
.فورعم قدصم عجرم نم ةعقوم ةداهش وأ يلخاد



ISE مداخب ةصاخلا IP نيوانعو FQDN نم لك ةفاضإ نامض ةديجلا تاسرامملا نم :حيملت
Cisco يف ةداهشلا ةقداصم نأ نامضل ،ماع لكشب .ISE ماظن ةداهش يف SAN لقح ىلإ
ISE ةداهش ىلإ دنتست يتلا ققحتلا فئاظو يف ةفيفطلا قورفلاب رثأتت ال،
يف ةروشنملا Cisco ISE دقع عيمجل ةريغصلا فرحألا تاذ ةفيضملا ءامسأ مدختسأ
.ةكبش

وأ (PEM) "ةيصوصخلل نسحملا ديربلا" وه ISE ةداهش قيسنت نوكي نأ بجي :ةظحالم
 .(DER) "ةزيمملا زيمرتلا دعاوق"

اهب قوثوملا تاداهشلا نزخم

نأ بجيو Administration > System > Certificates > Certificate Store  ىلع قدصملا عجرملا تاداهش نيزخت بجي
تاداهشلا هذه مدختسي ISE نأ نامضل مادختسإ ةلاح Trust for client authentication  مهيدل نوكي
.ىرخألا ISE دقع وأ ةزهجألا وأ ةياهنلا طاقن نم ةمدقملا تاداهشلا نم ققحتلل

ةيساسألا ماهملا



اذإ .ام ةطقن دنع اهلادبتساب ةبلاطملا وأ اهلاطبإ نكميو ةيحالص ءاهتنا خيرات ةداهشلل
ةداهشب اهلادبتسإ متي مل ام ةريطخ تالكشم رهظت دقف ،ISE مداخ ةداهش ةيحالص تهتنا
.ةحلاص ةديدج

،(EAP) عسوتملا ةقداصملا لوكوتوربل ةمدختسملا ةداهشلا ةيحالص تهتنا اذإ :ةظحالم
ةلاح يف .نآلا دعب ISE ةداهشب قثي ال ليمعلا نأل ءالمعلا ةقداصم لشفت دقف
ضفر تاضرعتسملاو ءالمعلل نكمي ،لخادملل مدختست ةداهش ةيحالص ءاهتنا
رطاخملا نوكت ،لوؤسملا مادختسإ ةداهش ةيحالص ءاهتنا ةلاح يف .لخدملاب لاصتالا
رشنلا فقوتي نأ نكميو نآلا دعب ISE ىلإ لوخدلا ليجست نم لوؤسملا عنمي امم ربكأ
.بجي امك لمعلا نع عزوملا

ايتاذ ةعقوم ةداهش ءاشنإ

Administration > System > Certificates > System  ىلإ لقتنا ،عيقوتلا ةيتاذ ةديدج تاداهش ءاشنإل
Certificates. قوف رقنا  Generate Self Signed Certificate.

.ايتاذ ةعقوم ةداهش ءاشنإ ةحفص يف ةدوجوملا لوقحلا ةمئاقلا هذه فصت

:ايتاذ ةعقوملا ةداهشلا تادادعإ لقح مسا مادختسإ تاداشرإ

●.ماظنلا ةداهش ءاشنإل اهيلإ جاتحت يتلا ةدقعلا (ةبولطم) :ةدقعلا ددح

CN: (نيزختلا ةقطنم ةكبش ديدحت متي مل اذإ بولطم (SAN)) نإف ،يضارتفا لكشب CN
.اهل يتاذلا عيقوتلا ةداهش ءاشنإ متي يتلا ISE ةدقعل FQDN يه

●

●.ةسدنهلا ،لاثملا ليبس ىلع ،ةيميظنتلا ةدحولا مسا :ةيميظنتلا ةدحولا

●.Cisco ،لاثملا ليبس ىلع ،ةسسؤملا مسا :(O) ةسسؤملا

●.هيسوخ ناس ،لاثملا ليبس ىلع ،ةنيدملا مسا (رصتخت ال) :(ل) ةنيدملا

●.اينروفيلاك ،لاثملا ليبس ىلع ،ةيالولا مسا (رصتخت ال) :(ST) ةيالولا

،لاثملا ليبس ىلع .نيفرحلا يذ ISO دلبلا زمر لاخدإ مزلي .دلبلا مسا :(ج) دلبلا
.ةدحتملا تايالولا

●

(URI) دحوملا دراوملا فرعم وأ DNS مسا وأ IP ناونع :(SAN) نيزختلا ةقطنم ةكبش
.ةداهشلاب نرتقملا

●

وأ RSA :ماعلا حاتفملا ءاشنإل اهمادختسإ متيس يتلا ةيمزراوخلا ددح :حاتفملا عون
ECDSA.

●

RSA: 512 1024 2048 ل تارايخلا هذه رفوتت .ماعلا حاتفملل تبلا مجح ددح :حاتفملا لوط
.ECDSA: 256 384 ل ةرفوتم تارايخلا هذهو 4096

●



●.SHA-256 وأ SHA-1 :هذه ةئزجتلا تايمزراوخ دحأ رتخأ :مادختساب عيقوتلل صخلم

اهعم قفاوتت نأ بجي يتلا OID تافرعمب ةمئاق وأ ةداهشلا جهن فرعم لخدأ :ةداهشلا جهن
.ةيلصألا ةزهجألا تافرعم لصفل تافاسملا وأ لصاوفلا مدختسأ .ةداهشلا

●

●.ةداهشلا ةيحالص اهدعب يهتنت يتلا مايألا ددع ددح :ةيحالصلا ءاهتنا ةدم

موقت Cisco ISE نإف ،مسا ديدحت متي مل اذإ .ةداهشلل افولأم امسا لخدأ :فولأم مسا
.تاناخ سمخ نم ديرف مقر وه   نيأ   قيسنتلاب مسا ءاشنإب ايئاقلت

●

ايتاذ ةعقوم لدب فرح ةداهش ءاشنإل هذه رايتخالا ةناخ ددح :لدبلا فرحأ تاداهشب حامسلا
ةكبش يف DNS مسا وأ/و عوضوملا يف CN يأ يف (*) ةيمجن ةمالع ىلع يوتحت ةداهش)
هنييعت مت يذلا DNS مسا نوكي نأ نكمي ،لاثملا ليبس ىلع .(SAN) نيزختلا ةقطنم
.SAN  *.domain.com ل

●

:يه ةحاتملا تارايخلا .اهل هذه ماظنلا ةداهش مادختسإ بجي يتلا ةمدخلا رتخأ :مادختسالا
ةباوبلماسEAPRADIUS DTLSpxGrid ةقداصملوؤسملا

●



ةفلتخم حيتافم لاوطأ ECDSA و RSA ل ةماعلا حيتافملل نوكي نأ نكمي :ةظحالم
نم ةعقوم ةماع ةداهش ىلع لوصحلا يه ةينلا تناك اذإ 2048 رتخأ .نامألا ىوتسم سفنل
CA رشن وأ Cisco ISE عم قفاوتم ةسايس ةرادإ ماظنك FIPS.

ايتاذ ةعقوم ةداهش ديدجت

Administration > System > Certificates > System  ىلإ لقتنا ،ةدوجوملا ايتاذ ةعقوملا تاداهشلا ضرعل
Certificates مكحت ةدحو يف ISE. عم ةداهش يأ 'Issued To' و'Issued By' يف اهركذ مت اذإ ISE Server
FQDN قوف رقناو ،ةداهشلا هذه رتخأ .ايتاذ ةعقوم ةداهش نوكت اهنإف ،هسفن  Edit.
ءاهتنال (TTL) ءاقبلا ةدم نييعتب مق مث Renewal Period  نم ققحت ،Renew Self Signed Certificate  تحت
.Save  رقنا ،اريخأ .ةجاحلا بسح ةيحالصلا

اهب قوثوم ةداهش تيبثت

(CA) قدصملا عجرملا نم 64 ساسألل اهزيمرت مت يتلا (تاداهشلا) ةداهشلا ىلع لوصحلا
.ةقثلل ةبولطملا ةفيضملا ةزهجألا وأ/و طيسولا (CA) قدصملا عجرملا وأ/و رذجلا



< Administration > System > Certificate > Certificate Management  ىلإ لقتناو ISE ةدقع ىلإ لوخدلا لجس .1
Trusted Certificates قوف رقناو  Import، ةروصلا هذه يف حضوم وه امك.

لوصحلا مت يتلا قدصملا عجرملا (تاداهش) ةداهش ليمحتب مق ،ةيلاتلا ةحفصلا يف .2
ضرغلا حضوي فصوو اهل فولأم مسا نييعتب مق .(اقباس حضوملا بيترتلا سفنب) اهيلع
.راسملا ةعباتم لجأ نم ةداهشلا نم

:ل ةرواجملا تاعبرملا ددح ،مادختسالا تاجايتحإ بسح

نوكت امدنع ةديدج ISE دقع ةفاضإ يف ةزيملا هذه لثمتت - ISE لخاد ةقداصملاب ةقثلا
.اهب صاخلا اهب قوثوملا تاداهشلا نزخم ىلع ةلمحم ةقوثوملا CA ةداهش سفن اهل

●

ةقداصمل ةداهشلا مادختسال كلذ نيكمتب مق - syslog وأ/و ليمعلا ةقداصمب ةقثلا
.ةنمآلا syslog مداوخ يف ةقثلا وأ/و EAP مادختساب ISE ب لصتت يتلا ةياهنلا طاقن

●

ةمدخ لثم ةيجراخلا Cisco تامدخ يف ةقثلل طقف اذه مزلي - Cisco تامدخ ةقداصمل ةقثلا
.بيولا زجوم

●

عم اهتنمازمو "هب قوثوملا نزخملا" يف ةيئرم ةداهشلا نوكت نأ نآلا بجي .Submit  رقنا ،اريخأ .3
.(رشنلا ةلاح يف) ةيوناثلا ISE دقع عيمج



CA نم ةعقوم ةداهش تيبثت

،هب قوثوملا تاداهشلا نزخم ىلإ طسوتملاو رذجلا (CA) قدصملا عجرملا تاداهش ةفاضإ درجمب
CSR ىلإ ةدنتسملا ةعقوملا ةداهشلا طبر نكميو (CSR) ةداهشلا عيقوت بلط رادصإ نكمي
.ISE ةدقعب

رقنا مث Administration > System > Certificates > Certificate Signing Requests  ىلإ لقتنا ،كلذب مايقلل .1
.CSR ءاشنإل Generate Certificate Signing Requests (CSR)  قوف

نم همادختسإ متيس يذلا رودلا رتخأ ،"مادختسالا" مسق نمض ،رهظت يتلا ةحفصلا يف .2
.ةلدسنملا ةمئاقلا

نكمي ،ةداهشلا ءاشنإ درجمب .ددعتم مادختسإ رتخأ ،ةددعتم راودأل ةمدختسم ةداهشلا تناك اذإ
اهمادختسإ متيل ةداهشلا نييعت نكمي ،تالاحلا مظعم يف .رمألا مزل اذإ راودألا رييغت
ةداهشلا نوكت نأب حمسي اذهو ؛ةمدختسملا ةلدسنملا ةمئاقلا يف ددعتملا مادختسالل
.ISE بيو تاباوب عيمجل مادختسالل ةلباق

.اهل ةداهشلا ءاشنإ متي يتلا (دقعلا) ةدقعلا رايتخال ISE (تادحو) ةدقعل رواجملا عبرملا ددح .3

.عبرم Allow Wildcard Certificates  نم ققحتف ،لدب فرح ةداهش ءاشنإ/تيبثت وه ضرغلا ناك اذإ .4



ةدحولا) ةمظنملا وأ فيضملاب ةقلعتملا ليصافتلا ىلإ ادانتسا عوضوملا تامولعم ألما .5
.(دلبلاو ،ةلودلا ،ةنيدملا ،ةمظنملا ،ةيميظنتلا

.يتأي يذلا قثبنملا ىلع Export  رقنا مث ،Generate  قوف رقنا ،اذه ءاهنإل .6



اذه PEM فلم لاسرإ بجي - وتلل هؤاشنإ مت Base-64 ىلإ زمرم ةداهش بلط ليزنتب اذه موقي
.(Base 64 زمرم) جتانلا عقوملا CER ةداهش فلم ىلع لوصحلاو ،عيقوتلل CA ىلإ

.دقعلل FQDN ءلمب ايئاقلت CN لقحب صاخلا ISE موقي :ةظحالم

مادختسال لقألا ىلع CSR يحلطصم رادصإ ابولطم ناك ،1.4 و ISE 1.3 يف :ةظحالم
pxGrid. ل صصخم امهدحأ PXgrid، ىلع اذه لك ،هدعب امو 2.0 ذنم .تامدخلا ةيقبل ،رخآلاو
CSR دحاو.



CN لقح يف '*' زمرلا نوكي الأ بجي ،EAP ةقداصمل ةداهشلا مادختسإ ةلاح يف :ةظحالم
Verify ليطعت دنع ىتح .مداخلا ةداهش نوضفري Windows يلومم نإ ثيح عوضوملل
Server Identity (مداخلا ةيوه ةحص نم ققحتلا) ةحفاصم لشفت نأ نكمي ،بولطملا ىلع
SSL لقح يف '*' نوكي امدنع CN. مادختسإ نكمي ،كلذ نم الدبو FQDN لقح يف ماع CN،
تاداهشلا عجارم ضعبل نكمي .SAN DNS مسا لقح يف همادختسإ نكمي domain.com.*  مث
(CA) يف (*) لدبلا فرح ةفاضإ CN يف ادوجوم نكي مل اذإ ىتح ايئاقلت ةداهشلل CSR.
.ءارجإلا اذه عنمل صاخ بلط ميدقت مزلي ،ويرانيسلا اذه يفو

،ويديفلا يف حضوم وه امك CSR نم اهؤاشنإ مت يتلا) CA لبق نم ةداهشلا عيقوت درجمب .7
ىلإ لقتناو ،(ISE) ةيموسرلا مدختسملا ةهجاو ىلإ لقتنا ،(Microsoft CA مادختسإ مت اذإ انه
CSR ل رواجملا عبرملا ددح ؛ةداهشلا عيقوت بلط < ةداهشلا ةرادإ < تاداهشلا < ماظنلا < ةرادإلا
.Bind Certificate رزلا قوف رقناو ،اقبسم هؤاشنإ مت يذلا

.ISE ل افولأم امسا اهطعأو ،وتلل اهيقلت مت يتلا ةعقوملا ةداهشلا ليمحتب مق ،كلذ دعب .8
و Admin ةقداصم لثم) ةداهشلل ةجاحلا بسح تامادختسالل ةرواجملا تاعبرملا رايتخإ عبات مث
EAP، رقناو (كلذ ىلإ امو ،لخدملاو Submit، ةروصلا هذه يف حضوم وه امك:

https://youtu.be/nBKzsGAXFyE?t=221


.اهتامدخ ليغشت ةداعإب ISE ةدقع موقت نأ بجيف ،ةداهشلا هذهل "لوؤسملا رود" رايتخإ مت اذإ
.ةقيقد 15 ىلإ 10 نم كلذ قرغتسي دق ،VM ل ةصصخملا دراوملاو رادصإلا ىلإ ادانتسا
show application status  رمألا ردصأو ISE رماوأ رطس حتفا ،قيبطتلا ةلاح نم ققحتلل
ise erasecat4000_flash:.



ةداهشلا نأ نم ققحتلا نكمي ،ةداهشلا داريتسإ دنع لخدملا وأ لوؤسملا رود رايتخإ مت اذإ
زمر رتخأ .ضرعتسملا يف لخدملا تاحفص وأ لوؤسملا ىلإ لوصولا دنع ةدوجوم ةديدجلا
ةدوجوملا ةلماكلا ةلسلسلا نم راسملا ققحتي ،صيخرتلا تحتو حفصتملا يف نيمأتلا
لخدملا وأ لوؤسملا ةداهش يف ضرعتسملا قثي نأ بجي .زاهجلا لبق نم اهب قوثوملاو
ةلسلس يف قثي ضرعتسملا ناك اذإو حيحص لكشب ةلسلسلا ءاشنإ مت املاط ةديدجلا
.تاداهشلا

طبرو ،ديدج CSR ءاشنإب مق ،CA لبق نم ةعقوم ماظن ةداهش ديدجت لجأ نم :ةظحالم
ىلع ةديدج ةداهش تيبثت نكمملا نم هنأ امب .تارايخلا سفنب اهب ةعقوملا ةداهشلا
ISE ةيحالص ءاهتنا لبق ةديدجلا ةداهشلا تيبثتل ططخ ،ةطشن نوكت نأ لبق
ةميدقلا ةداهشلا ةيحالص ءاهتنا خيرات نيب هذه لخادتلا ةرتف .ةميدقلا ةداهشلا
تقو عم اهلدابتل طيطختلاو تاداهشلا ديدجتل اتقو حنمت ةديدجلا ةداهشلا ءدب خيراتو
خيراتب ةديدج ةداهش ىلع لصحا .لمعلا نع فقوت تقو دجوي ال وأ ليلق لمعلا نع فقوت
نيذه نيب ةينمزلا ةرتفلا .ةميدقلا ةداهشلا ةيحالص ءاهتنا خيرات قبسي ءدب
حيحصلا خيراتلا قاطن ةديدجلا ةداهشلا لخدت نأ درجمب .رييغتلا ةذفان يه نيخيراتلا
مت اذإ هنأ ركذت .(admin/EAP/Portal) ةبولطملا تالوكوتوربلا نيكمتب مق ،اهب صاخلا
.ةمدخلا ليغشت ةداعإ متتسف ،Admin مادختسإ نيكمت

EAP و Admin تاداهشل ةكرشلل يلخادلا قدصملا عجرملا مادختساب ىصوي :حيملت
اذإ هنأ وه ببسلا .كلذ ىلإ امو/Guest/Sponsor/Hotspot تاباوبل ماع لكشب ةعقوم ةداهشو
عاطقلا نم ةعقوم ةداهش ISE ةباوب تمدختساو ةكبشلا ىلإ فيض وأ مدختسم لخد
نأ لمتحي وأ ةداهشلا يف ءاطخأ ىلع مدختسملا لصحيسف ،"فويضلا لخدم" ل صاخلا
ةداهش مدختسأ ،كلذ لك بنجتل .ةباوبلا ةحفص نم ءاطخألا رظحب ضرعتسملا موقي
ةفاضإلابو .لضفأ مادختسإ ةبرجت نامضل ةباوبلا مادختسال ةماعلا لبق نم ةعقوم
نيزختلا ةكبش لقح ىلإ رشن (دقع) ةدقعل IP ناونع ناونع لك ةفاضإ بجي ،كلذ ىلإ
(SAN) ناونع ربع مداخلا ىلإ لوصولا دنع ةداهش ريذحت بنجتل IP.

ةصاخلا حيتافملاو يطايتحالا خسنلا تاداهش

:ريدصتلاب ىصوي
مزلي) ةصاخلا اهحيتافم ىلإ ةفاضإلاب (رشنلا يف دقعلا عيمج نم) ماظنلا تاداهش عيمج .1
مت يتلا ةمدخلا) ةداهشلا نيوكتل ةظحالمب ظافتحالا .نمآ عقوم ىلإ (اهتيبثت ةداعإ
.(اهل ةداهشلا مادختسإ

ظافتحالا .ةيساسألا ةرادإلا ةدقعل اهب قوثوملا تاداهشلا نزخم نم تاداهشلا ةفاك .2
.(اهل ةداهشلا مادختسإ مت يتلا ةمدخلا) ةداهشلا نيوكتل ةظحالمب



.تاداهشلا ةئيه تاداهش عيمج .3

،كلذب مايقللو

رتخأ .Administration > System > Certificates > Certificate Management > System Certificates  ىلإ لقتنا
ةملك لخدأ .ةصاخلا حيتافملا ءاقتنا رزو Export Certificates  راتخن .Export  رقناو صيخرتلا
.Export  رقنا .رورملا ةملك ديكأتب مقو صاخلا حاتفملا رورم

1.

رتخأ .Administration > System > Certificates > Certificate Management > Trusted Certificates  ىلإ لقتنا
.ةداهشلا ريدصتل Save File  رقنا .Export  رقناو صيخرتلا

2.

رتخأ .Administration > System > Certificates > Certificate Authority > Certificate Authority Certificates  ىلإ لقتنا
ةملك لخدأ .ةصاخلا حيتافملا ءاقتنا رزو Export Certificates  راتخن .Export  رقناو صيخرتلا
ريدصتل Save File  رقنا .Export  رقنا .رورملا ةملك ديكأتب مقو صاخلا حاتفملا رورم
.ةداهشلا

3.

اهحالصإو ءاطخألا فاشكتسا

ةداهشلا ةحص نم ققحتلا

وأ ماظنلا تاداهش نزخم يف ةداهش يأ ةيحالص ءاهتنا ةلاح يف ةيقرتلا ةيلمع لشفت
ءاهتنا خيرات لقح يف ةيحالصلا نم ققحتلا نم دكأت .Cisco نم اهب قوثوملا ISE تاداهش
< Administration > System > Certificates) ماظنلا تاداهشو اهب قوثوملا تاداهشلا تاراطإل ةيحالصلا
Certificate Management)، ةيقرتلا لبق ،رمألا مزل اذإ ،اهديدجتو.

تاداهش ةذفان يف ةدوجوملا تاداهشلل ةيحالصلا ءاهتنا خيرات لقح يف ةيحالصلا اضيأ عجار
،(Administration > System > Certificates > Certificate Authority > Certificate Authority Certificates) قدصملا عجرملا
.ةيقرتلا لبق ،رمألا مزل اذإ ،اهديدجتو

ةداهش فذح

ريدصت نم دكأت .اهتلازإ مزلي ،اهمادختسإ مدع وأ ISE يف ةداهش ةيحالص ءاهتنا ةلاح يف
.فذحلا لبق (نكمأ نإ ،ةصاخلا اهحيتافمب) تاداهشلا

.Administration > System > Certificates > Certificate Management  ىلإ لقتنا ،ةيحالصلا ةيهتنم ةداهش فذحل
رقناو اهتيحالص تهتنا يتلا (تاداهشلا) ةداهشلا رتخأ .System Certificates Store  قوف رقنا
.Delete  قوف
.ةلوخملا عجارملاو ةلوخملا تاداهشلا نزاخمل ئيشلا سفن عجار

1x .802 ةقداصم يف ISE مداخ ةداهش بلاط قثي ال

.SSL ةحفاصم ةيلمعل ةلماكلا تاداهشلا ةلسلس لسري ISE ناك اذإ امم ققحت

يف مداخلا ةيوه نم ققحتلاو (PEAP يأ) مداخ ةداهش بلطتت يتلا EAP بيلاسأ ديدحت عم
تاداهشلاب تاداهشلا ةلسلس نم بلطلا مدقم ققحتي ،ليمعلا ليغشت ماظن تادادعإ
ةحفاصم ةيلمع نم ءزجك .ةقداصملا ةيلمع نم ءزجك يلحملا ةقثلا نزخم يف هيدل ةدوجوملا
SSL، مدقي ISE ال .هب ةصاخلا ةلسلسلا يف ةدوجوم طيسو وأ/و رذج تاداهش يأ كلذكو هتداهش
تناك اذإ وأ ةلماك ريغ ةلسلسلا تناك اذإ مداخلا ةيوه نم ققحتلا نم بلاطملا نكمتي
.هب صاخلا ةقثلا نزخم يف ةلسلسلا هذه ىلإ رقتفت

< ISE (Operations نم ةمزح طاقتلا ذخأب مق ،ليمعلا ىلإ تاداهشلا ةلسلس ةداعإ نم ققحتلل



Diagnostic Tools > General Tools > TCP Dump) طاقتلا وأ Wireshark تقو يف ةياهنلا ةطقن ىلع
Wireshark ةكرش يف ssl.handshake.certificates حشرملا قيبطتب مقو طاقتلالا حتفا .ةقداصملا
.لوصولا يدحت ىلع روثعلاو

Expand Radius Protocol > Attribute Value Pairs > EAP-Message Last segment > Extensible  ىلإ لقتنا ،رايتخالا درجمب
Authentication Protocol > Secure Sockets Layer > Certificate > Certificates.

ققحتلاو ISE  Administration > Certificates > Trusted Certificates ىلإ لقتنا ،ةلماك ريغ ةلسلسلا تناك اذإ
بجي ،حاجنب تاداهشلا ةلسلس ريرمت ةلاح يف .ةطيسولا تاداهشلا وأ/و رذجلا تاداهش دوجو نم
.انه ةحضوملا ةقيرطلل اقفو اهسفن ةلسلسلا ةحص نم ققحتلا

حاتفم فرعم ةقباطمل ةقثلا ةلسلس نم ققحتو (رذجو ،طسوتم ،مداخ) ةداهش لك حتفا
يف ةيلاتلا ةداهشلل (AKI) ةطلسلا حاتفم فرعم ىلإ ةداهش لكل (SKI) عوضوملا
.ةلسلسلا

ءانثأ ISE مداخ ةداهش ضفرت ةياهنلا ةطقن نكلو ةحيحص ISE ةداهش ةلسلس
ةقداصملا

ةلسلس ضفري سمتلملا لظو SSL ةحفاصمل ةلماك تاصيخرت ةلسلس ISE مدق اذإ
يف ةدوجوم ةطيسولا وأ/و رذجلا تاداهشلا نأ نم ققحتلا يه ةيلاتلا ةوطخلا نإف ،تاداهشلا
.يلحملا ينامئتسالا ءالمعلا نزخم

،mmc.exe(Microsoft Management Console)  ليغشتب مق ،Windows زاهج نم كلذ نم ققحتلل
رقناو Certificates  رتخأ ،رفوتملا ةيفاضإلا تاودألا دومع نم .File > Add-Remove Snap-in  ىلإ لقتنا
مدختسملا ةقداصملا عون ىلإ ادانتسا Computer account  وأ  My user account  امإ رتخأ .Add  قوف
. OK  قوف رقنا مث (زاهج وأ مدختسم)

قيدصتلا تاطلسو اهب قوثوملا رذجلا ةقداصم عجارم رتخأ ،مكحتلا ةدحو ضرع تحت
.يلحملا ةقثلا نزخم يف طسوتملاو رذجلا تاداهشلا دوجو نم ققحتلل ةطسوتملا

نم ققحتلا ءاغلإب مق ،مداخلا ةيوه نم ققحتلا يف ةلكشم هذه نأ نم ققحتلل ةلهس ةقيرط
.ىرخأ ةرم اهربتخا مث بولطملا فيرعتلا فلم نيوكت تحت مداخلا ةداهش ةحص

ةرركتملا ةلئسألا

ةدوجوم ةداهشلا نأب ريذحت هيجوتب ISE موقي امدنع هلعف بجي يذلا ام
؟لعفلاب

تمت دقو ،طبضلاب OU ةملعم سفن اهل ماظن ةداهش نع تفشك ISE نأ ةلاسرلا هذه ينعت
ةطاسبب حصني ،ةموعدم ريغ ةرركملا ماظنلا ةداهش نأ امب .ةرركم ةداهش تيبثت ةلواحم
ةداهشلا نأ نامضل اليلق ةفلتخم ةميق ىلإ مسقلا/ةلاحلا/ةنيدملا ميق نم يأ رييغتب
.ةفلتخم ةديدجلا

ISE نم لخدملا ةحفص نأ ىلإ ريشي ريذحت هيجوتب ضرعتسملا موقي اذامل
؟هب قوثوم ريغ مداخ ةطساوب ةمدقم

.مداخلا ةيوه ةداهشب ضرعتسملا قثي ال امدنع كلذ ثدحي



اهنيوكت متو اعقوتم ناك ام يه ضرعتسملا ىلع ةيئرملا ةباوبلا ةداهش نأ نم دكأت ،الوأ
.ةباوبلل ISE ىلع
نم دكأت ،مادختسالا ديق IP ناونع ةلاح يف - FQDN ربع ةباوبلا ىلإ لوصولا نم دكأت ،ايناث
.ةداهشلا نم CN وأ/و SAN يلقح يف IP ناونعو FQDN نم لك دوجو
CA تاداهش ،طيسولا ISE، CA (CA) لخدم) ةباوبلا تاداهش ةلسلس داريتسإ نم دكأت ،اريخأو
.ليمعلاب صاخلا ضرعتسملا/ليغشتلا ماظن جمانرب ةطساوب اهب قوثوم/ىلع (رذجلا

اهل Chrome/Firefox و Android OS و iOS تاحفصتم نم ثدحألا تارادصإلا ضعب :ةظحالم
لاصتالا ضفر اهنكميف ،طاقنلا هذه ةيبلت مت اذإ ىتح .ةداهشلل ةمراص نامأ تاعقوت
.SHA-256 نم لقأ ةطيسولا CAs و Portal ةميق تناك اذإ

؟ةحلاصلا ريغ تاداهشلا ببسب ةيقرتلا لشف دنع هلعف بجي يذلا ام

وأ ماظنلا تاداهش نزخم يف ةداهش يأ ةيحالص ءاهتنا ةلاح يف ةيقرتلا ةيلمع لشفت
ءاهتنا خيرات لقح يف ةيحالصلا نم ققحتلا نم دكأت .Cisco نم اهب قوثوملا ISE تاداهش
< Administration > System > Certificates) ماظنلا تاداهشو اهب قوثوملا تاداهشلا تاراطإل ةيحالصلا
Certificate Management)، ةيقرتلا لبق ،رمألا مزل اذإ ،اهديدجتو.

تاداهش ةذفان يف ةدوجوملا تاداهشلل ةيحالصلا ءاهتنا خيرات لقح يف ةيحالصلا اضيأ عجار
،(Administration > System > Certificates > Certificate Authority > Certificate Authority Certificates) قدصملا عجرملا
.ةيقرتلا لبق ،رمألا مزل اذإ ،اهديدجتو

.ةيلخادلا CA تاداهش ةلسلس ةحص نم دكأت ،ISE ةيقرت لبق

رتخأ ،رشنلا يف ةدقع لكل .Administration > System > Certificates > Certificate Authority Certificates  ىلإ لقتنا
.فولأملا مسالا دومع يف تاداهشلا تامدخ ةياهن ةطقنل يعرفلا قدصملا عجرملا تاذ ةداهشلا
.ةيئرمو ةديج ةلاسر ةداهشلا ةلاح تناك اذإ امم ققحتو View  رقنا

لجأ نم .ةيلمع نيسحت cisco ISE لا نأ لبق رادصإلا تبثي نأ تنمض ،ترسك ةداهش يأ نإ
Administration > System > Certificates > Certificate Management > Certificate Signing  ىلإ لقتنا ،ةلكشملا حالصإ
Requests، رايخل دحاو ءاشنإو ISE Root CA.

ةلص تاذ تامولعم

ISE 2.7 تاداهشلا نزخم تادادعإو تاداهشلا ةرادإ●

●ISE يف ةيمقرلا تاداهشلا ذيفنت

●Cisco Systems - تادنتسملاو ينقتلا معدلا

/content/en/us/td/docs/security/ise/2-7/admin_guide/b_ise_27_admin_guide.html
https://community.cisco.com/t5/security-knowledge-base/how-to-implement-digital-certificates-in-ise/ta-p/3630897.
https://www.cisco.com/c/ar_ae/support/index.html


ةمجرتلا هذه لوح
ةيلآلا تاينقتلا نم ةعومجم مادختساب دنتسملا اذه Cisco تمجرت
ملاعلا ءاحنأ عيمج يف نيمدختسملل معد ىوتحم ميدقتل ةيرشبلاو
امك ةقيقد نوكت نل ةيلآ ةمجرت لضفأ نأ ةظحالم ىجرُي .ةصاخلا مهتغلب
Cisco يلخت .فرتحم مجرتم اهمدقي يتلا  ةيفارتحالا ةمجرتلا عم لاحلا وه
Systems ىلإ اًمئاد عوجرلاب يصوُتو تامجرتلا هذه ةقد نع اهتيلوئسم
.(رفوتم طبارلا) يلصألا يزيلجنإلا دنتسملا


